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Abstract 

Introduction: One of the important challenges in investigating the hydraulic, morphological 

and ecological behavior of rivers is to accurately determine the geometrical dimensions of 
river bed particles.  The information extracted from the grain size curve of river bed particles 

has many applications in the field of river engineering, such as modeling of sediment 

transport, changes in sediment deposition or river bed erosion, and changes in river 
morphology (Hasannejad Sharifi et al., 2015). Nowadays, despite the fact that determining 

the granularity of the bed particles and the boundaries of rivers is important, the removal of 

sediments from the natural environment leads to disturbing the sedimentary bed and causes 
changes in the river system (Sadeghi and Qara Mahmoudoli, 2013). Therefore, it is very 

important to use a method that can calculate the results of granulation with less cost and 

quickly. Image processing methods are known as new methods have been taken into 
consideration in order to increase rapidity and accuracy, along with the method of field 

measurement of granularity. 

Methodology: In this research, by examining the morphological and sedimentary conditions 
of the rivers of the Zanjan province, as well as the ease of access, Zanjanrud river was 

selected as the study area. Then three cross-sections for sampling with frame dimensions of 

20×20 cm were determined from the bed of Zanjanrud river and after photographing the 
surface of the samples, painting by spray paint in order to identify the surface grains, 

sampling was done from the determined sections. The samples were taken to the laboratory 

and the sieve test was performed. Then, in the laboratory environment, each of the samples 
was arranged in a metal frame with dimensions of 20×20 cm and was installed in a channel 

with a length of 8 meters and a width of 20 cm. By applying the conditions of stagnant water 

at three depths of 4, 8 and 12 cm and water flow with different depths and velocities, the 
samples were re-photographed and the grain size curve were obtained by Image J and 

Hydraulic Toolbox softwares. 

Results and discussion: Based on the results of Sieve, in sample A, almost 85% of the 
particles have a diameter equal to and less than 31.7 mm. In sample B, almost 85% of the 

particles passed through the sieve of 1.38 mm. In sample C, more than 97% of the particles 

passed through the 38.1 mm sieve. According to the classification system of the United 

States, the sediments of all three sections of Zanjanrud are gravel. Also, according to the
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results, it can be seen that the standard deviation of the samples is less than 2, the uniformity 
coefficient is less than 4, and the sorting coefficient is less than 2, which shows that the 

examined samples are almost uniform.  In sample A, at depth of 8 cm, the average relative 

absolute error values were obtained similar to those at depth of 4 cm. In sample B, the 
average error value of the fine grains is the same as the coarse grains. The reason for this can 

be due to the low value of the standard deviation of this sample compared to the other two 

samples. The average error value at depth of 8 cm was found to be 14% for fine grains and 
12% for coarse grains. In sample C, similar to sample A, the average error value in the fine 

grains is less compared to the coarse grains. The average relative error at depth of 8 cm was 

found to be 9% for fine grains and 14% for coarse grains. Results showed that Image J 
software has better performance than Hydraulic Toolbox software in determining the 

particles granulation curve of the Zanjanrud river. 

The effect of flow velocity and depth on the K values of the index diameter of 50% showed 
that at depth of 4 cm, the average values of K in samples A, B, and C are 1.01, 1.19, and 1.08, 

respectively. Also, at depth of 8 cm, the values of K for samples A, B, C are equal to 1.05, 

1.12, and 1.11, respectively, and at depth of 12 cm, there are equal to 1.08, 1.18, and 1.13, 
respectively. According to these results, it can be seen that the K values of sample A are 

lower than the other two samples in all three depths of 4, 8, and 12 cm. At depth of 8 cm, the 

K values of sample B at different velocities coincide approximately with those of sample C. 
Also, the K values of sample C at two depths of 4 and 12 cm are lower than the K values of 

sample B. The average K values of the 50% index diameter at three depths of 4, 8, and 12 of 

sample A are 1.01, 1.05, and 1.08, respectively (with an average value of 1.046); the mean K 
values of sample B are 1.19, 1.12 and 1.18 respectively (with an average value of 1.16) and 

also the mean K values of sample C are 1.08, 1.11 and 1.13 respectively (with an average 

value of 1.1) (with a total average of 1.1 for all three samples). 

Conclusion: In most of the hydraulic flow conditions, the granulation curve obtained by 

Image J software is close to the sieve granulation curve. In contrast, the Hydraulic Toolbox 

granulation curve is significantly different from the sieve curve and the curve of Image J 
software. The flow velocity and flow depth does not have a noticeable effect on the K values 

of the index diameter of 50%. 

Keywords: Image processing, Surface layer, Granulation curve, Shape factor, Image  J, 

Hydraulic Toolbox. 
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جر  ریتاث  یاب یارز سرعت  و  شکل    یبنددانهنتایج  بر    ان ی عمق  و 

سطح رسوبات  رودخانه  یذرات  از    ی شن  یها بستر  استفاده  با 

 ریپردازش تصو  هایروش
 

 3قربان مهتابی ،*2سیدعلی ایوب زاده  ،1مریم سهرابی
 

 دانشگاه تربیت مدرس، تهران های آبی، گروه مهندسی و مدیریت آب، کارشناس ارشد سازه -1

 استاد گروه مهندسی و مدیریت آب، دانشگاه تربیت مدرس، تهران   -2

 گروه مهندسی آب، دانشگاه زنجان، زنجان  دانشیار -3

 
رفتار هیدرولیکی، ریخت  :چکیده بررسی  رودخانهدر  اکولوژیکی  از چالش  هاشناسی و  زبری  یکی  ابعاد هندسی  تعیین دقیق  های مهم، 

با   یشن یهابستر رودخانه یو شکل ذرات رسوبات سطح  یبنددانهنتایج بر  انیعمق و سرعت جر ریتاثدر این تحقیق  هاست.بستر رودخانه

پردازش تصو از روش  نمونهگردید.    یابیارز  ریاستفاده  ابعاد قاب  سه مقطع جهت  با  زنجانرود  سانتی  20×20برداری  بستر رودخانه  از  متر 

. در محیط آزمایشگاه، هر یک از  شدی  بندبا روش الک دانهآوری و  ها جمع رسوبات نمونهبرداری از سطح رسوبات،  تعیین و پس از عکس

متر نصب شد. با اعمال شرایط آب سانتی  20متر و عرض    8متر چیده و در کانالی به طول  سانتی  20×20ها داخل قاب فلزی با ابعاد  نمونه

و نتایج    ها صورت گرفتنمونهبرداری مجدد از  های مختلف، عکسمتر و جریان آب با عمق و سرعت سانتی  12و    8،  4ساکن در سه عمق  

نتایج منحنی  پردازش گردید.   Hydraulic Toolboxو    Image J  هایافزارتوسط نرم  از نرم های دانهمقایسه  -نشان  هاافزاربندی حاصل 

نرم بهتر  عملکرد  نتایج  باشد.می  Hydraulic Toolboxافزار  نرم  هبنسبت    Image Jافزار  دهنده  ومطابق  عمق  تاثیر    ،  جریان  سرعت 

بطوریکه    ،( نداردK)ضریب    Image Jافزار  محسوسی روی نسبت مقادیر قطرهای شاخص منحنی الک به قطرهای شاخص حاصل از نرم 

بدست آمد. نتایج فاکتور شکل نشان داد از   1/1و  16/1، 046/1به ترتیب برابر با  Cو  A ،Bدر سه نمونه  %50در قطر شاخص  Kمیانگین 

ذرات بیضوی و در   % 22ذرات مستطیلی و    B  78%ذرات، بیضی شکل هستند. در نمونه   % 12و    یذرات مستطیل  A  88%دید قائم، در نمونه  

 ذرات، بیضی شکل هستند.  % 20ذرات مستطیلی و    C  80%نمونه  

 

 IMAGE J , HYDRAULIC TOOLBOXافزار  رود، نرمشکل، زنجان سطحی، فاکتور  لایه  ،بندیدانه  تصویر، منحنی پردازش: كلیدواژگان

 

 مقدمه  -1
عنوان ها بهزندگی انسان در اساسی نقشها همواره  رودخانه

و  اندداشته  سطحی،آب مهم منبع  یک ابعاد  دقیق  تعیین   .

رودخانه مهممشخصات  از  بستر  رسوبات  و  مساها  ل  ئترین 

میرودخانه دانهها  تعیین  برای  متداول  روش  بندی  باشد. 

خاک روش الک است. برای تعیین اندازه توزیع ذرات بستر 

آوری شده و به  های مصالح جمعها، نمونهرودخانه یا آبراهه

بندی بر روی آنها  شوند تا آزمون دانهآزمایشگاه منتقل می

  بستر  ذرات  بندیدانه  منحنی  از  که  اطلاعاتی   انجام گیرد.

استخراج   زمینه   در  اوانی فر  کاربردهای   شود،می  رودخانه 

 تعیین  رسوبات،  انتقال سازیمدل  مانند  رودخانه  مهندسی

  تغییرات   و  رودخانه  بستر  فرسایش  یا  گذاریرسوب  وضعیت

 ,.Hassannejad Sharifi et alدارد )  رودخانه  شناسیریخت

دبی طرفی    زا  (.2016 سرعت   رودخانه  اشل-محاسبات    و 

  دارد،   بستگی  بستر  شکلو    زبریاندازه    بـه  کـاملا  جریـان

 بسـتر  شکلاندازه زبری و    یعنـی تغییـرات  خصوصیات  این

اثـر  اشل-دبی  رابطهر  د  مهمی  تأثیر  آب  جریان  در 

به یک    اشل-دبی  رابطه  .دارد  سیل  عبور  هنگام   بخصوص 

  عمق  تعیین  برای  که  است  مقابل جریان  در  مقاومت  معادله

  مواد   خصوصیات  شیب،  کانال،  شکل  دبی،  کهصورتی  در  آب

. (White et al., 2005)  رودمی  کار  بـه،  مشخص باشد  بستر

ها با  رودخانه  میبندی مصالح بستر و حرتعیین دانهبنابراین  

از محیط طبیعی منجر اما    ،اهمیت است برداشت رسوبات 

را در سیستم  به برهم زدن بستر رسوبی شده و تغییراتی 

به میرودخانه  )وجود   Sadeghi andآورد 

ویراستاری نشده
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Gharamahmudli, 2013  طرفی از  هز(.  علت    های نهیبه 

نمونه رودخانه،گزاف  از  دستی  به  نمونه  انتقال  برداری  ها 

هز  شگاه یآزما آزما  هاینهیو  به  مکانیک    هایشیمربوط 

پوشی های مهندسان مشاور از آن چشمخاک، اکثر شرکت

  شگاه یآزما  هاینهیحاضر به قبول هز  ان یکارفرما  و   کنند می

از روشی که با هز کمتر و   نهینیستند. لذا اهمیت استفاده 

بندی را محاسبه کند،  از دانه حاصل ج یبتواند نتا بالا سرعت 

 .(Zarei et al., 2019) اهمیت است زیبسیار حا

پردازش تصویر روش جدیدی است که در کنار  روش های 

اندازه دانهگیری  روش  افزایش میدانی  منظور  به  بندی 

است. گرفته  قرار  توجه  مورد  دقت  و  روش   سرعت  در 

نمونهنمونه معمولاً  بستر،  سطحی  مصالح  از  از  برداری  ها 

برداشت می  رودخانه  بستر  این مصالح  عمق  اندازه  و  شوند 

تماس در  جریان  با  که  بستر  سطحی  ذرات  با  اند،  عمدتا 

نمی  بنابراین  دانهمتفاوت هستند،  از  نتیجه درستی  -توان 

در   رودخانه  جریان  با  که  بستر  مصالح  بندی لایه سطحی 

 .(Bunte and Abt, 2001)تماس مستقیم هستند، گرفت  

نمونه  1شکل   شکبرداری  نحوه  و  نمونه   2  لعمقی  نحوه 

 .(Anonymous, 2007  (دهد برداری سطحی را نشان می

 تصویر،  پردازش  تکنیک اساس  بر  خاک  بندیدانه  مزایای  از

  بندی دانه  آزمایش   انجام  یهزینه  و  زمان  در  جوییصرفه

ارایه  معمول  روش  به  نسبت   مناطق   از  دقیق  اطلاعات  و 

  شناسایی،   بزرگتر،  مناطق  به  هانمونه  تعمیم  و  کوچک

  زمانی   و  مکانی  توزیع  ترآسان  تعیین  و  گیری، تحلیلاندازه

 از   توانمی  طرفی  از.  (Penders, 2010)  نمود  اشاره  ذرات

  به   آسیب  بدون  دسترس  غیرقابل   مناطق   در  رسوبی  ذرات

به  مورد  سطح   این   با.  کرد  تصویربرداری  آسانی   مطالعه 

  و   رودخانه  بستر  رسوبات  از  تصویربرداری  کیفیت  وجود،

  و   هیدرولیکی   تاثیر عوامل  تحت  آنها  تصویر  پردازش  دقت

  پدیده   و  خورشید  تابش   شدت:  مانند  مختلف  محیطی

 جریان(،  عمق  تغییرات  از  )ناشی  آب  عمق  در  نور  شکست

  نیروی  جریان(،   سرعت  تغییرات  از  )ناشی  آب  سطح   تلاطم

 . باشد می  عکاسی پایه سه به آب جریان از وارده

 

 
Fig. 1 Deep sampling method 

 برداری عمقی نحوه نمونه  1شکل 

  
Fig. 2 Surface sampling method 

 نحوه نمونه برداری سطحی   2شکل 
 

پیشرفت   عکاسی   هایدوربین  ترویج  و  تکنولوژی  با 

و    تجزیه  برای  مختلفی  افزارهاینرم  و  ها الگوریتم  دیجیتال،

  تصاویر   از  استفاده  با   بستر  اطلاعات  خودکار  تحلیل

البته اند.  شده  ارائه  ها  آبراهه  بستر  از  شده  اخذ  دیجیتالی

استاندارد از  رعایت  تصویر  پردازش  روش  بر  حاکم  های 

سنجی این روش با روش متداول الک  عوامل مهم در صحت

توان به عواملی نظیر قدرت  باشد. از این استانداردها میمی

مورد  الگوریتم  و  تصویر  قاب  اندازه  دوربین،  تفکیک 

اندازه ذرات   تا بستر و  فاصله دوربین  اشاره  استفاده،  بستر 

در فاصله  زمان عکاسی  شرایط نور یکسان )همچنین    کرد.

نبود سایه و در صورت امکان ابری  وجود نور متعادل،  ،  ظهر

آسمان روش    هایمحدودیتاز    (بودن    است این 

(Hassannejad Sharifi et al., 2016; Sadeghi and 

Gharamahmudli, 2013; Azizian and Samadi, 2019) . 

 اشاره به منابع   -1-1

عکسدر    روش  شبکهمعرفی  بستر برداری  از  ای 

دانه  برایرودخانه ّ درشتتعیین  بستر  محافظ  لایه  -بندی 

کرج( رودخانه  موردی:  )مطالعه  فراز عکس   ،دانه  از  برداری 

. نتایج حاصل نشان داد که روش  شد نقاط یک شبکه انجام  

نمونهپردازش   به  نیاز  بدون  و  سریع  روشی  برداری  تصویر 

 . (Abd Sharif Esfahani et al., 2006) باشدمی

در ارتباط با استفاده از روش پردازش تصویر، الگوریتمی در  

متل افزار  نرم  که  ب  محیط  شد  استخراج  ایجاد  توانایی 

ویراستاری نشده
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مشخصات هندسی مصالح سطحی بستر رودخانه را از روی 

نتایج نشان داد که الگوریتم توسعه   دارد.تصاویر تهیه شده  

می را  شده  مطالعات  داده  در  مناسب  دقت  با  توان 

ریخت رسوب هیدرولیکی،  فرسایش  و  رودخانه  شناسی 

 . (Azizian et al., 2013) مورد استفاده قرار داد

زمینه   رودخانهدر  ذرات  بندی  دانه  توزیع  با  تخمین  های 

الگوریتم روشاز    بستر شنی الگوریتم حوضه آبخیز و  های 

. نتایج نشان  شدافزار متلب استفاده  بازسازی تصویر در نرم

داد که راندمان تخمین قطر ذرات در مدل بازسازی تصویر 

آبخیز    3/96 حوضه  الگوریتم  مدل  در  و  درصد    66درصد 

ود. این امر حاکی از برتری نسبی فیلتر بازسازی تصویر در ب

می روش  این  و  بود  آبخیز  حوضه  الگوریتم  تواند  مقابل 

سریع و  روشکارآمدترین  جایگزینی  برای  روش  های  ترین 

 . (Payesteh et al., 2018)  سنتی، مانند الک کردن شود

الگوریتم کارایی  بررسی  به  تحقیقی  مختلف    هایدر 

و   Hydraulic Tool Box و   Image Jشاملپردازش تصویر  

GIAS  در تعیین زبری هیدرویکی به کمک منحنی دانه-

پرداخته شبندی در رودخانه  سهیبا مقاد.  های بستر شنی 

 Basegrainو    Hydraulic Tool Boxو     Image Jعملکرد  

شد  جهینت افزار  گیری  نرم   Hydraulic Tool Box Jکه 

بهتر منحن  یعملکرد  استخراج  بند  یدر    یبسترها  یدانه 

   .(Zarei et al., 2019) دارد یشن

ای   مطالعه  بندیدر    دو   در  هاآبراهه  سطحی  مصالح  دانه 

سیرج    پردازش  با  تر  و  خشک  حالت )رودخانه  تصویر 

 Imageافزارهایمنر  مقایسه عملکردکرمان( تعیین گردید.  

J  و Hydraulic Tool Box  وGIAS که نرم افزار  نشان داد

Image J   بندی دانه  منحنی  استخراج  در  بهتری  عملکرد 

 .(Azizian and Samadi, 2019) دارد

منظور   دانهبه  منحنی  درشتبرآورد  رسوبات  دانه بندی 

.  یکپارچه استفاده شدسیستم تصویربرداری  یک  سطحی از  

رســوبات تر    رودخانه  پردازش  و  خشک  حالت  با  در 

نرمگرفت.  انجام   ImageJ افزارنرم نتایج  افزار مقایســه 

ImageJ   الک روش  افزار   با  نرم  دقت خوب  دهنده  نشان 

 .(Tabee et al., 2023) بود

دانه تعیین  بررسی  در  از  پس  بستر،  رسوبات    39بندی 

اندازه )با  نمونه  شده  تصویربرداری  و  از  گیری  استفاده 

انگلیس در  رودخانه  سه  بستر  در  تصویر(،  این    پردازش 

 95که پردازش تصویر در سطح اعتماد  نتیجه حاصل شد  

 . (Graham et al., 2005)  درصد دارای دقت مناسبی است

از یک  استفاده  با  الوا  رودخانه  دلتای  پژوهشی در سواحل 

-ابعاد رسوبات درشت  تعیینروش خود همبستگی جهت  

عکسدانه   پردازش  طریق  رسوبات از  از  شده  تهیه  های 

. نتایج نشان داد خطای روش مورد استفاده  شدبستر انجام  

محدوده   در  ذرات  متوسط  اندازه  برآورد    200تا    1در 

 .(Warrick et al., 2009) باشد درصد می 14متر برابر میلی

به منظور تعیین اندازه متوسط ذرات رسوبی با استفاده یک  

های دارای شیب  خودکار پردازش تصویر در رودخانهروش  

در   که  گردید  گزارش  شد،  انجام  موارد،    85زیاد  درصد 

حداکثر   تصویر  پردازش  روش  نتایج    50نتایج  با  درصد 

 .(Penders, 2010)روش الک اختلاف داشتند 

دیجیتالی   تصاویر  پردازش  بر  مبتنی  روش  یک  بکارگیری 

به   ذرات  شمارش  روش  مقابل  منحنی در  تعیین  منظور 

روش مبتنی بر تصاویر  بندی ذرات سنگی نشان داد که دانه

ب ناحیه  دیجیتالی  شش  از  ناحیه  پنج  در  قبولی  قابل  طور 

 .(Strom et al., 2010) مورد مطالعه نتایج خوبی نشان داد 

مالزی،   در  واقع  شنی  بستر  با  راسیل  رودخانه   کیتکندر 

با  ذرات  اندازه  خودکار   Image Jافزار  نرم  کمک  تعیین 

( گردید  بیانگر  نتایج  (.  Sulaiman et al., 2014بررسی 

 .بودتوانایی خوب نرم افزار خصوصا در دامنه ذرات ریز 

تصویر   پردازش  روش  دانهکاربرد  تعیین  بندی  جهت 

رودخانه تسکو واقع در ایتالیا  کیلومتری    3در بازه  رسوبات  

و گزارش شد (  Di Francesco et al., 2016)  گردید  ارزیابی

تع  یخوب  عملکرد   Image Jافزار  نرم اندازه    عیتوز  نییدر 

 دارد.ذرات 

مطالعات    با تصویر،  پردازش  موضوع  بودن  جدید  به  توجه 

خصوص   گسترده رسوبات   در  هندسی  مشخصات  تعیین 

ابهامات و سوالات  سطحی بستر رودخانه صورت نگرفته و 

این   استفاده  قابلیت  اجرا و خصوصا  زیادی در زمینه نحوه 

رودخانه انواع  بستر  مطالعات  روش در  مرور  دارد.  ها وجود 

تاکنون تحقیقی در زمینه تاثیر عمق    دهدنشان میپیشین  

رودخانه   در  جریان  کانال و سرعت  بر  یا  روی آزمایشگاهی 

است.   نشده  ارائه  تصویر  پردازش  طرفی  نتایج  در از 

ویراستاری نشده
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 نیبرا  نیرودخانه، همواره تلاش مهندس  یمطالعات مهندس 

که   شرا  یشگاهیآزما  تحقیقاتاست  به  ممکن  حد   طیتا 

 .شود کسباز موضوع  ید تا درک بهترنباش کینزد  یدانیم

اندازه امکان  اینکه  به  توجه  و  گیریبا  عمق  میدانی  های 

 عدم وجودسرعت جریان در رودخانه زنجانرود فراهم نبود ) 

گیری  آلودگی جریان آب، نبود تجهیزات اندازهجریان یا گل

در    انیجر  طیشرا  د یگرد  یسعمطالعهاین    در،  ..( و. زلال 

نمونه  و   گرددایجاد    شگاه یآزما تهیه  رسوبات  با  از  هایی 

زنجانرود بستر  افزار    ارزیابی  ،سطحی  و   Image Jنرم 

Hydraulic Tool Box  منحن استخراج  بند  یدر    ی دانه 

  ان یمختلف عمق و سرعت جر  طیدر شرا  یرسوبات سطح

 انجام گرفت. در شرایط آزمایشگاهی  آب زلال

 

 ها مواد و روش -2
 معرفی رودخانه مورد مطالعه  -2-1

رودخانه رسوبی  و  مورفولوژیکی  شرایط  بررسی  های  با 

زنجانرود   حوضه  در  واقع  زنجانرود  رودخانه  زنجان،  استان 

انجام   با  شد.  انتخاب  مطالعه  مورد  رودخانه  عنوان  به 

مقاطع   و  طولی  بازه  رودخانه،  مسیر  از  میدانی  بازدیدهای 

دانه تعیین  برای  گردید. مناسب  مشخص  مصالح    بندی 

نمونه برای  مسیر مقاطعی  در  که  شدند  انتخاب  برداری 

ر عرضی  ودخانهاصلی  و  طولی  یکنواخت  شیب  قرار    با 

قابل برداشت و عاری از هرگونه ،  بستر شنیو دارای    داشته

گل و  از    ولای لجن  دانهی  فطرباشند.  در  یکنواختی  بندی 

امکان حد  تا  عرضی  محاسبات   مقطع  بودن  دقیق  موجب 

بود.  رودخانه بازه  خواهد  کیلومتری در طول  نیم  تقریبا  ی 

 E  ″32  ′08  º48موقعیت جغرافیایی   زنجانرود از حدفاصل

 N  ″33  ′55و    E  ″22  ′08  º48تا    N  ″24  ′55    º36و  

º36 برداری در نظر گرفته شد. به عنوان محدوده نمونه 

 نحوه نموه برداری میدانی  -2-2

متر    200مقطع با فاصله طولی تقریبی    3برداری در  نمونه

با  از یکدیگر صورت گرفت.   )اولین مقطع بصورت تصادفی 

قابی  ویژگی برای هر مقطع  انتخاب شد(.  های مطرح شده 

متر در نظر گرفته شد.  سانتی  20×20مربعی شکل به ابعاد  

محل تعیین  از  نمونهپس  مرحله  های  اولین  برداری، 

نمونه از  میتصویربرداری  از ها  تصاویر  تهیه  برای  باشد. 

مدل   نیکون  مکانی    D7200دوربین  تفکیک  قدرت    24با 

تهیه   جهت  است  ذکر  به  لازم  شد.  استفاده  مگاپیکسل 

پردازش،   برای  تصویر  به بهترین  نسبت  دوربین  بایستی 

باشد قائم  تصویربرداری  دوربین سطح  از  منظور  بدین   .

سه تراز،  به  ارتفمجهز  تنظیم  قابلیت  با  سطح  پایه  از  اع 

سایه   و  دست  لرزش  از  ناشی  خطای  حذف  جهت  زمین 

 انداخت روی زمین و قاب استفاده شد.  

مسیر  میدانی  پیمایش  در  موجود  مشکلات  به  توجه  با 

مورد تصویربرداری  تجهیزات  حمل  و  در    رودخانه  و  نیاز، 

جهت سهولت و دقت بالای تصویربرداری با بستر رودخانه،  

پایه ثابت و قابل  فقی فلزی و سهی ادوربین روی یک میله

گردید مستقر  در    .حمل  موردنظر  مقاطع  از  تصویربرداری 

متری تا سطح بستر و 1از فاصله  متری  سانتی  20×20قاب  

صورت   تصویربرداری  سطح  بر   نیدورببودن  عمود  حالت  با  

نیمه در  آفتابی  شرایط  در  تصویربرداری  روز پذیرفت.  ی 

ساعت   مستقیم   11-13)مابین  بصورت  آفتاب  که  ظهر 

و سایه از تابیده  پس  باشد( صورت گرفت.  نشده  ایجاد  ای 

نمونه برداشت تصویربرداری،  تا  شدند  رنگ  اسپری  با  ها 

بیشتری نمونه دقت  با  و  گرفته  بصورت سطحی صورت  ها 

آوری گردند. ذرات رسوبی با دقت  برای آزمایش الک جمع

کیس جمعهداخل  شد ها  آزمایش    و   آوری  انجام  منظور  به 

زنجان   دانشگاه  آب  مهندسی  گروه  آزمایشگاه  به  الک 

برداری را  شرایط موجود برای نمونه  3منتقل گردید. شکل  

 دهد. نمایش می
 

 

Fig. 3 Sampling cross section of Zanjanrud river 

 زنجانرود ی  برداری شده رودخانه مقطع نمونه  3 شکل
 

 های مورد استفادهمعرفی روش  -2-3

  Image J مدل  -2-3-1
 ImageJ (Image Processing and Analysis inافزار  نرم

Java)   و است  تصاویر  آنالیز  برای  قدرتمند  برنامه  یک 
ملی    هموسس افزار توسط  کاربردهای مختلفی دارد. این نرم

ویراستاری نشده
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شده   طراحی  آمریکا  متحده  ایالات  بر  بهداشت  که  است 
در   بسیاری  استفاده  و  شده  نوشته  جاوا  پلتفورم  روی 

افزار کاربردهای فراوانی  تصویربرداری پزشکی دارد. این نرم
اندازه   و  ذرات  تعداد  فازها،  درصد  محاسبه  جمله:  از  دارد 
ذرات، در زمین شناسی به منظور تعیین مساحت، محیط،  

برازش   جهت  هندسی.  مشخصات  سایر  و  کرویت  و  قطر، 
استخراج دقیق مساحت، محیط، قطر کوچک و قطر بزرگ 

های موجود در تصاویر از دستورات متعددی  و کرویت دانه
می نرماستفاده  توسط  تصویر  پردازش  مراحل  افزار شود. 

Image J :به صورت زیر است 

منظور    - به  خط  ابزار  از  استفاده  با  تصویر:  دهی  مقیاس 

شیده و اندازه آن را  دهی، کاربر طولی مشخص را کمقیاس

کند. به منظور تعیین دقیق خط مقیاس، قطر قاب  وارد می

 .  (Analyze -> Set Scale) شوددر نظر گرفته می

خاکستری    - تصویر  به  تصویر  - Image)  بیتی  8تبدیل 

>Type->8-Bit)   

: این فیلتر به برطرف کردن خش و  Medianاعمال فیلتر    -

ذرات  لکه روی  از  میها  کمک  تصویر  در    کند موجود 

(Process->Filters->Median).  

ای: در این مرحله تصویر به ایجاد نواحی حدی یا آستانه  -

می تبدیل  باینری  دو  حالت  تنها  تصویر  در  واقع  در  شود. 

می چشم  به  دیگری  رنگ  و  ذرات  به  مربوط  یکی  خورد؛ 

  های سیاه رنگ مربوطمربوط به پس زمینه. در تصویر لکه

زمینه  و  ذرات  نمونهبه  داده  ی  نمایش  سفید  رنگ  به  ها 

  .(Image->Adjust->Threshold) شودمی

استفاده از عملگر پخش: برنامه به صورت خودکار ذراتی    -

را که در تماس با یکدیگرند یا همپوشانی دارند، از یکدیگر  

می نقشه  جدا  تشکیل  از  پس  که  ترتیب  بدین  کند. 

شدهاقلیدسی،   خوردگی  دچار  که  را  نقاطی  اند،  دورترین 

یابد؛ سپس هر یک از این نقاط را تا جای ممکن اتساع می

 (Process->Binary->Watershed)  دهدمی

بیضی  - ضلعیبرازش  چند  یا  به  ها  برنامه  ذرات:  بر  ها 

ها را بر ذرات موجود  ها و بیضیترتیب بهترین چند ضلعی 

باینری   تصویر  یک  میبیتی  8در  محیط  این  کند.،  در 

هستند،   شن  نوع  از  دهنده  تشکیل  ذرات  چون  مرحله، 

با   برابر  ذره  سایز  نظر    240کوچکترین  در  گرفته  پیکسل 

تمامی    .(Damadipour et al., 2019)  شد منظور  بدین 

پیکسل از محاسبات پردازش تصویر   240ذرات کوچکتر از  

 (.Analyze->Set Measurementsشوند )حذف می

سنگدانه  - ابعاد  آنالیز  نتایج  اخذ  امکان  نهایت  بر  در  ها 

اکسل محیط  در  شده  داده  برازش  هندسی  شکل    اساس 

و   آمده  دانهمی بدست  منحنی  کرد توان  رسم  را    بندی 

(Analyze-> Analyze Particles).   

 Hydraulic Toolboxمدل    -2-3-2
Hydraulic Toolbox ای است که شامل مجموعه ای برنامه

مستقل از ابزارهای محاسباتی در زمینه محاسبات و تجزیه  
باشد. این  و تحلیل هیدرولیکی، هیدرولوژیکی و طراحی می

سال  نرم در  شرکت 2014افزار  به    Aquaveo  توسط 
سفارش اداره بزرگراه های فدرال وزارت راه و ترابری ایالات  

است.   یافته  توسعه  امریکا  آن   متحده  تخصصی  ابزارهای 
کانالعبارت هیدرولوژیکی،  منطقی  روش  آنالیز  از  ها،  اند 

بندی رسوبات و... این برنامه  ها، دانهسرریزها، آبشستگی پل
را می امکان  این  تبه کاربر  را  دهد  ا محاسبات هیدرولیکی 

چندین   کند،  ذخیره  و  داده  انجام  پروژه  فایل  یک  در 
هایی از این  سناریو را تجزیه و تحلیل و نمودارها و گزارش

نرم این  در  نماید.  استخراج  را  ها  تحلیل  و  افزار تجزیه 
بندی رسوبات وجود دارد که با  الگوریتمی برای تعیین دانه
تواند منحنی  ها می بستر آبراههدریافت تصویر دیجیتالی از  

ذرات تشکل    d50, d15, d5d ,… ,100بندی و نیز قطرهای دانه
 دهنده بستر را سریعا تهیه نماید. 

 :اند ازمراحل پردازش تصویر به ترتیب عبارت

تصویر  در  مقیاس  تعیین طول خط  باید    الف(  )این طول 

 . برداری از محل تعیین گردد(حین عکس

 تصویر رنگی به تصویر خاکستری هشت بیتیب( تبدیل 

فیلتر   از  تصویر  دادن  عبور  به    Medianج(  فیلتر  )این 

ها از روی ذرات موجود در تصویر برطرف کردن خش و لکه

 . نماید(کمک می

 د( اعمال عملگر پس زمینه

آستانه یا  نواحی حدی  ایجاد  حالت  ه(  به  را  تصویر  که  ای 

می تبدیل  حباینری  این  در  دو  کند.  تنها  تصویر  در  الت 

و   ذرات  به  مربوط  یکی  که  خورد  خواهد  چشم  به  رنگ 

 شود. ها میزمینه آندیگری مربوط به پس

از عمل استفاده  تصویر و(  استخراج مشخصات هندسی  گر 

(Watershedding  که به کمک آن ذراتی که در تماس با )

هم  یا  و  بوده  از یکدیگر  خودکار  صورت  به  دارند،  پوشانی 

 شوند. یگر جدا مییکد

 با پردازش، فرآیند تکمیل برای ها بر ذراتز( برازش بیضی

 ها،بیضی از یک هر (b) و متوسط  (a) بزرگ قطر محاسبه

ویراستاری نشده
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موجود ذرات تمامی مساحت  محاسبه تصویر در منفرد 

 باشدمی ذرات تصویر دوبعدی شامل تنها نتایج این  .گردید

متوسط با ذرات معمولاً که جا آن از و  بزرگ و قطرهای 

 راستای در (c) کوچک قطر و گیرندمی قرار بستر روی خود

 منحنی از آمده دست  به معادل قطر لذا شود،می واقع قائم

 و متوسط قطرهای میانگین از حاصل تنها تصویر، پردازش

 روش این در ذرات اندازه توزیع منحنی و بوده ذرات بزرگ

 داشت.  خواهد اختلاف  الک با بندی دانه منحنی با

از   حاصل اولیه هایمنحنی اصلاح منظور افزار بهدر این نرم

های  منحنی  بین  مقایسه  امکان  ایجاد  نیز  و  تصویر  پردازش

 تصویر،  پردازش  و   الک  با   بندیدانه  روش   دو   به  مربوط

یک  معمولاً پیش  می   استفاده  تصحیح  ضریب  از  که  گردد 

 باشد.  می 5/2فرض نرم افزار عدد 

 

 شرح كار آزمایشگاه   -2-4
در  نمونه زنجانرود،  رودخانه  بستر  از  شده  برداشت  های 
آوری شده و به آزمایشگاه گروه  های جدا از هم جمعکیسه

بندی  مهندسی آب دانشگاه زنجان منتقل شد. پس از دانه
نمونه الک،  رودخانه توسط  بستر  از  که  تصویری  طبق  ها 

یک   درون  بود،  شده  ابعاد  برداشت  به  گالوانیزه  جعبه 

عمق  سانتی  20×20 با  به  سانتی  2متر  شد.  چیده  متر 
نمونه چیدمان  تدقیق  بستر منظور  تصاویر  رنگی  چاپ  ها، 

ها به رودخانه تهیه گردید. به منظور قرارگیری دقیق سنگ
همان شکل موجود در رودخانه، از ماسه به عنوان خاک پر  

شکل   شد.  استفاده  بستر  همراه  ونهنم  4کننده  به  قاب  ی 
  دهد. برداری برای پردازش تصویر را نمایش می روش نمونه

  20متر، عرض  8در آزمایشگاه، نمونه درون کانالی به طول 
ارتفاع  سانتی و  سیستم سانتی   30متر  دارای  که  متر 

گرفت. قرار  بود،  پذیر  شیب  و  آب  سپس    چرخش 
مراحل   از  کدام  هر  در  و  اجرا  نظر  مورد  سناریوهای 

کانال   تصویر  گرفت.  صورت  آزمایشگاهی  تصویربرداری 
استفاده   همراه  مورد  به  کانال  شماتیکی  نمای  و همچنین 

نشان داده شده است. روند کار    5در شکل  جرئیات و ابعاد  
نمونه برداشت شده از رودخانه به    3زمایشگاه برای هر  آدر  

ورت بوده و مراحل انجام کار در ادامه تشریح شده  یک ص
است. در ابتدا پس از چیدن رسوبات داخل هر نمونه جعبه 

 ، نمونه داخل کانال قرار داده شد. 6 شکل گالوانیزه
های مختلف( با استفاده  برای حالت اول )آب ساکن با عمق

از شیر فلکه، جریان آب را به آرامی در کانال برقرار کرده و  
،  8،  4های  بستن دریچه انتهایی کانال، آب ساکن با عمق  با

 

 
Fig. 4 Frame sample with sampling method 

 برداری ی قاب به همراه روش نمونهنمونه   4شکل 
 

 
a) The image of the laboratory model used in the research 

(a  مورد استفاده در پژوهش از مدل آزمایشگاهی    یتصویر 

ویراستاری نشده










؟؟؟؟  ؟؟؟؟، ؟ ، شماره؟؟دوره  هیدرولیک     

  

 
Journal of Hydraulics  

??(?), ???? 
9 

 

 

 

 
b) Longitudinal profile  

(b    دید از  نمای شماتیکی)جانب )پروفیل طولی  

 

 
 

c) Plan  

(c    دید از بالانمای شماتیکی   )پلان( 

 
Fig. 5 Actual image (a), the image of the laboratory model used in the research (b), longitudinal profile plan (c) 

 مورد استفاده در پژوهش   (c)  کانال  ( و دید از بالای b)  جانبدید از  نمای شماتیکی    (،a)  واقعی  تصویر  5شکل 

       a) Natural river bed                 b) Printed color image                     c) Box with sand bed            d) Arrangement inside box 

d           چیدمان داخل جعبه )       cای     ( جعبه با بستر ماسه                 b   تصویر رنگی چاپ شده )       aتصویر بستر طبیعی رودخانه ) 

Fig. 6 The steps of arranging sediments inside the galvanized box 

 مراحل چیدمان رسوبات داخل جعبه گالوانیزه   6شکل 
 

حالتسانتی  12 از  یک  هر  از  و  گردید  برقرار  ها  متر 
حالت برای  شد.  انجام  و  تصویربرداری  )عمق  بعدی  های 

های مختلف( با باز کردن شیر فلکه و تنظیم دریچه سرعت
  4عمق و سرعت مورد نظر تنظیم گردید. در عمق    ،انتهایی
  ی انتهایی مقادیر متر با افزایش دبی و تنظیم دریچهسانتی
گردید و پس از  های مختلف برای همان عمق برقرار سرعت

برداری  تصویر  آب،  سطح  در  موجود  تلاطم  رفتن  بین  از 
  برای هر حالت صورت گرفت. لازم به ذکر است به منظور 

و   آزمایشگاه  در  یکسان  تصویربرداری  شرایط  برقراری 
ی  رودخانه )نور ثابت و عدم وجود سایه در تصاویر و فاصله

، از یک  (متری دوربین تا سطح ذرات و عدم لرزش دست 1
تامین   به منظور  افزایش چهارپایه تاشو  نیاز و  ارتفاع مورد 

از نمونه از هر یک  تصویر برداشت   3ها  دقت استفاده شد. 
خطای تا  دست   شد،  لغزش  یا  آب  سطح  تلاطم  از  ناشی 

بیشتری  وضوح  که  تصویری  نهایت  در  کند.  پیدا  کاهش 
پردازش   اصلی  تصویر  عنوان  به  کار  گردیدداشت  همین   .

انجام گردید. در هر عمق  متر نیز  سانتی  12و    8برای عمق  
سرعت مختلف( ایجاد شد.    5الی    4دبی )  5الی    4به تعداد  

های یک نمونه، اقدام  پس از تهیه تصاویر حاصل از آزمایش
 ها شد. به تغییر نمونه و انجام مجدد آزمایش
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آزمایش تمام  در محدوده  در  دبی  ثانیه،   1-12ها،  بر  لیتر 
فرود در محدوده متوسط   65/0تا    08/0ی  عدد  و سرعت 

محدوده در  بود.    5/0تا    08/0ی  جریان  ثانیه  بر  به  متر 
-منظور سهولت در ارائه نتایج و اختصار نویسی، اشکال نام

بیانگر   اول،  انگلیسی  حرف  نمونه،  هر  در  گردید.  گذاری 
متر و سری نمونه، پارامتر دوم عمق جریان برحسب سانتی

شد. به عنوان مثال  باپارامتر سوم نیز شماره دبی جریان می
-سانتی  4در عمق    حالت آب ساکنبه ازای    Aی  در نمونه

و    12/3،  06/2،  1/1مقادیر دبی  حالت جریان آب با  متر و  
نام  16/4 ترتیب  به  عمق  همان  در  ثانیه  بر  گذاری لیتر 

-Aو    A-04-00  ،A-04-01  ،A-04-02  ،A-04-03  بصورت

هر یک  با توجه به روش کار    سپس  .صورت گرفت  04-04
نرم مطالعهافزارهای  از  تصویر  مورد  پردازش  تصاویر    تمام ، 

نرم این  نتایج،  در  آمدن  بدست  از  پس  شد.  انجام  افزارها 
دانه دانهمنحنی  منحنی  سپس  شد.  رسم  بندی  بندی 

نرم از  یک  هر  از  الک  حاصل  از  حاصل  منحنی  با  افزارها 
تصاویر، ضریب   از  برای هر یک  و  قطرهای    Kمقایسه شد 

منحنی  (  85d, 50d, 35d, 15d)شاخص   و  شد  محاسبه 
هر    Kتغییرات ضریب   در  و سرعت،  جریان  عمق  ازای  به 

برای قطر شاخص   Kضریب   1نمونه ترسیم گردید. رابطه  

id باشد. بصورت زیر می 

(1) 
i s

i cal

d
K

d

−

−

=

 
( 85d, 50d, 35d, 15d)  قطرهای شاخص  s-id،  که در این رابطه

قطرهای شاخص بدست    cal-idبدست آمده از منحنی الک،  
شد.  باآمده از منحنی حاصل از نرم افزار پردازش تصویر می

به   ضریب  این  مقدار  چه  دقت    تردیکنز  1هر  باشد، 
برای  است  ذکر  شایان  بود.  خواهد  بالاتر  تصویر  پردازش 

نسبی مطلق  خطای  مقادیر  افزار نرم  (RAE)  محاسبه 
Image J    وHydraulic Toolbox   قطرهای برآورد  در 

 شاخص منحنی الک، از رابطه زیر استفاده گردید. 
(2) 

100
− −

−

=
−


i s i cal

i s

d d
Relative Absolute Error

d
 

رابطه   این  در  شاخص    قطرهایمشاهداتی  مقادیر    s-idکه 
(85d, 50d, 35d, 15d  )  ،حاصل از الکcal-id    محاسباتی  مقادیر

نرم(  85d, 50d, 35d, 15d)شاخص    قطرهای از  افزار حاصل 
   د.نباشمی

بعدی از    رداری دوتصویرب،  برای محاسبه فاکتور شکل ذرات
اساس تضاد رنگ موجود بین سپس برنمونه صورت گرفته،  

شود. پس  ابعاد سنگ محاسبه می  ،ی سنگزمینه و لبهپس

توسط   تعییناز   ذرات  و کرویت  و محیط  مقادیر مساحت 
 شده توسط  استفاده، با توجه به الگوریتم  Image Jافزار  نرم

Damadipour et al. (2019)  ،  و  تعیین  درصد شکل ذرات
گردید.   پارامتر  دربا  ایشان  تفسیر  دو  گرفتن    ERSنظر 

(idesSectangle Rquivalent E)    وEEA  (quivalent E

xisesAllipse E)،    شکل پردازش را    A/2Pفاکتور    برای 
پیشنهاد و  دو بعد  ریتصاو از    کردند  گزارشی    نیااستفاده 

تخم به  منجر  ذرات  عیتوز  بهتر  نیپارامتر    . شودیم   اندازه 
ترتیب   مساحت  بدین  به  ذره  محیط  مربع  (  A/2P) نسبت 
به    محاسبه شد توجه  با  پیشنهادیو  ذره    ،الگورتیم  شکل 

   . تعیین گردیداعم از مربع، مستطیل یا کره 

 نتایج و بحث  -3
  Cو    A  ،Bبندی الک مربوط به نمونه  منحنی دانه  7 شکل

می نمایش  نمونه  را  ذرات  قطر    Aدهد.  متر  میلی  1/38از 

تقریبا  کوچک بوده و  از    %85تر  برابر و کمتر  ذرات قطری 

الک  میلی  7/31 از  ذرات  عبوری  درصد  دارند.   75/4متر 

، تمام ذرات از الک  Bاست، در نمونه    %5متر کمتر از  میلی

از الک   %85تر بوده و تقریبا  متر کوچکمیلی  4/44 ذرات 

از الک متر عبور کردهمیلی  1/38 اند. درصد وزنی رد شده 

ذرات از کل    ، Cنمونه    در  است.  %5متر کمتر از  میلی  76/4

بالای  کوچک  مترمیلی  4/44الک   و  بوده  از   %97تر  ذرات 

عبور کردهمیلی  1/38الک   از متر  عبوری ذرات  اند. درصد 

از  میلی  75/4الک   کمتر  سیستم  است.    % 5متر  اساس  بر 

بندی متحد، رسوبات هر سه مقطع بستر زنجانرود از  طبقه  

می مشاهده  نتایج  به  توجه  با  هستند.  شن  که  نوع  شود 

، ضریب یکنواختی کمتر از 2ها کمتر از انحراف معیار نمونه

از    4 -باشد که نشان میمی  2و ضریب جورشدگی کمتر 

 های مورد بررسی تقریبا یکنواخت هستند.دهد نمونه
 

 

Fig. 7 Sieve granulation curve of samples A, B, C 

 A, B , Cبندی الک نمونه  منحنی دانه  7شکل 
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نتایج  مقایسه   -3-1 و    Image jافزار  نرمی 

Hydraulic Toolbox  الک   بر مبنای نتایج 
دانه  8شکل   منحنی  نرمنتایج  از  حاصل   افزارهای  بندی 

Hydraulic Toolbox  نرم با   Image Jافزار  و  مقایسه  در 

از آزمون الک نمونه برای   Cو    Bو    Aهای  منحنی حاصل 

متر و شرایط جریان سانتی  8  عمق آب  شرایط هیدرولیکی

مختلف ارائه شده است. در این شکل ستون   هایبا سرعت

نمونه   نتایج  ترتیب  به  سوم  و  دوم  و    Cو    A  ،Bاول، 

و  قرمزهای  منحنی آبی  نتایج    سبز،  به  مربوط  ترتیب  به 

الک،   باشد.  می  Hydraulic Toolboxو    Image Jآزمون 

می جریان،  مشاهده  هیدرولیکی  شرایط  عمده  در  شود 

دانه نرممنحنی  از  حاصل  منحنی    Image Jافزار  بندی  به 

دانهدانه منحنی  مقابل  در  و  بوده  نزدیک  الک  بندی  بندی 

منحنی    اختلاف  ،Hydraulic Toolboxافزار  نرم با  زیادی 

 دارد.  Image Jافزار الک و منحنی نرم

-نتایج حاصل از نرممتری  سانتی  8در عمق    Aی  در نمونه

الک   Image Jافزار   از  حاصل  نتایج  با  بسیار کمی  خطای 

ها میانگین خطای مطلق نسبی دانهکه در ریزدارد. بطوری

ی نمونه. در  شودمشاهده می  %2ها  دانهولی در درشت  9%

B  درشت و  ریزدانه  بخش  در  خطا  میانگین  دانه مقدار 

می امر  این  دلیل  است.  بودن  یکسان  پایین  از  ناشی  تواند 

دیگر   نمونه  دو  به  نسبت  نمونه  این  معیار  انحراف  مقدار 

عمق   در  خطا  میانگین  مقدار    برای متری  سانتی  8باشد. 

د. در  بدست آم  %12دانه  و برای درشت   %14ها برابر  ریزدانه

متری سانتی   8در عمق  ی نسبی  میانگین خطا  Cی  نمونه

بدست آمد.    %14و درشت دانه برابر    %9ریزدانه برابر    برای

می کلی  حالت  ضریب در  مقدار  هرچه  کرد  بیان  توان 

یکنواختی نمونه کمتر باشد، مقدار خطا در بخش ریزدانه و  

معیار  است. از طرفی هرچه انحراف  دانه کمتر شده  درشت

بود. خواهد  بیشتر  خطا  مقدار  باشد،  جدول    کمتر    1در 

معیار   از  انحراف  معیار    نتایجمقادیر  انحراف  و  الک  آزمون 

است.    Image Jافزار  نرم  نتایج شده  داده  یک  نشان  در 

 Image Jافزار  بندی کلی با توجه به دقت مناسب نرمجمع

به عنوان    افزاربندی، نتایج این نرمدر استخراج منحنی دانه

قطرهای    Kمبنای کار در نظر گرفته شد و در ادامه مقادیر  

 افزار ارائه شده است.شاخص این نرم
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 متر سانتی 8عمق در  Image Jو  Sieve ،Hydraulic Toolboxحاصل از  جینتا 8شکل 

 
Fig. 8 The results of Sieve, Hydraulic Toolbox and Image J at depth of 8 cm with different flow velocities 

فهای مختل متر با سرعت جریانسانتی  8عمق  در    Image Jو    Hydraulic Toolbox،  الکحاصل از    جینتا  8شکل 

 

 Image Jافزار  مقادیر انحراف معیار حاصل از آزمون الک و نرم  :1جدول 
Table 1 The standard deviation values obtained from the sieve test and Image J software 

Sample 

Standard 

deviation 

of sieve 

Standard 

deviation of 
Image J 

Sample 
Standard 

deviation 

of sieve 

Standard 

deviation of 
Image J 

Sample 
Standard 

deviation 

of sieve 

Standard 

deviation of 
Image J 

A-04-00  

 

 

 

 

 

 

1.68  

1.8353 B-04-00  

 

 

 

 

 

 

1.61 

1.7451 C-04-00  

 

 

 

 

 

 

1.91 

1.8708 

A-04-01 1.8378 B-04-01 1.8027 C-04-01 1.7175 

A-04-02 1.8126 B-04-02 1.7182 C-04-02 1.6475 

A-04-03 1.7842 B-04-03 1.7994 C-04-03 1.7320 

A-08-00 1.8210 B-08-00 1.8496 C-08-00 1.7149 

A-08-01 1.8650 B-08-01 1.7580 C-08-01 1.8209 

A-08-02 1.8210 B-08-02 1.8384 C-08-02 1.7349 

A-08-03 1.8027 B-08-03 1.8165 C-08-03 1.7471 

A-12-00 1.7861 B-12-00 1.7320 C-12-00 1.8629 

A-12-01 1.8122 B-12-01 1.8210 C-12-01 1.7320 

A-12-02 1.8637 B-12-02 1.7986 C-12-02 1.7471 

A-12-03 1.8496 B-12-03 1.8918 C-12-03 1.7600 

 

  Kتاثیر سرعت و عمق جریان بر روی مقادیر    -3-2

  %50شاخص    قطر

 تاثیر سرعت جریان 

تاثیر سرعت جریان بر روی مقادیر   11و    10،  9در اشکال  

K    سه    %50قطر شاخص برای  بررسی  مورد  عمق  در سه 

ها محور ارائه شده است. در این شکل  A , B , Cی  نمونه

بعد   بی  صورت  به  سرعت  مقادیر  محور   ( V/Vc)افقی  و 

مقادیر   شاخص    Kعمودی  مشاهده    باشد.می  %50قطر 

مقادیرمی روی  بر  قطر شاخص   K شود که سرعت جریان 

متر  سانتی   4تاثیر محسوسی ندارد. بطوریکه در عمق    50%

و    01/1به ترتیب    A , B , Cی  در نمونه  Kمیانگین مقادیر  

عمق  می  08/1و    19/1 در  همچنین  متر، سانتی  8باشد. 
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به ترتیب برابر است با   A , B , Cهای  برای نمونه  Kمقادیر  

متر، به ترتیب سانتی  12و در عمق    11/1و    12/1و    05/1

با   نتایج  می  13/1و    18/1و    08/1برابر  این  طبق  باشد. 

  8و    4در هر سه عمق    Aنمونه    Kشود مقادیر  مشاهده می

تر است. در  دیگر پایین  متر نسبت به دو نمونهسانتی  12و  

های  در سرعت  Cو    Bنمونه    Kمتری مقادیر  سانتی  8عمق  

مقادیر  تقریبا  مختلف   است. همچنین    Kروی هم منطبق 

  Kمتر نسبت به مقادیر  سانتی  12و    4در دو عمق    Cنمونه  

 کمتر است.   Bنمونه 
 

 
Fig. 9 The effect of flow velocity on the value of K at a 

depth of 4 cm at index diameter of 50% 

متر  سانتی  4در عمق    Kاثر سرعت جریان بر مقدار    9شکل 

 %50در قطر شاخص  

 
Fig. 10 The effect of flow velocity on the value of K at a 

depth of 8 cm at index diameter of 50% 

متر در  سانتی  8در عمق    Kاثر سرعت جریان بر مقدار   10شکل 

 % 50قطر شاخص  

 
Fig. 11 The effect of flow velocity on the value of K at a 

depth of 12 cm at index diameter of 50% 

متر  سانتی  12در عمق    Kاثر سرعت جریان بر مقدار    11شکل 

 %50در قطر شاخص  
 

 تاثیر عمق جریان   -3-3

به   14و    13و    12  هایدر شکل تغییر عمق جریان  تاثیر 

سرعت مقادیر  ازای  روی  بر  مختلف  شاخص    Kهای  قطر 

نمونه   50% است.    A , B , Cی  برای سه  داده شده  نشان 

بر  تاثیر محسوسی  نتایج در هر نمونه عمق جریان  مطابق 

قطر   Kمقادیر متوسط   وقطر شاخص نداشته  Kروی مقدار 

نمونه    %50شاخص   عمق    Aبرای  سه  به    12و    8،  4در 

متوسط    08/1و    05/1،    01/1ترتیب   مقدار  (؛  046/1)با 

نمونه   ترتیب    Bبرای  مقدار    18/1و    12/1،  19/1به  )با 

نمونه  16/1متوسط   برای  و   )C    ترتیب و    11/1،  08/1به 

  1/1باشد )با میانگین کل  ( می1/1)با مقدار متوسط    13/1

دهنده نشان  نتیجه  این  نمونه(.  سه  بودن هر  اثر  بی  ی 

های پدیده شکست نور در نتایج تصاویر تهیه شده در عمق

  90تصاویر با زاویه دید  باشد. با توجه به اینکه  میمختلف  

-سانتی  20×20درجه از یک صفحه افقی با ابعاد کوچک )

متر( تهیه شده است، با افزایش عمق اثر زاویه شکست نور  

در تصویر تهیه شده ناچیز است. شایان ذکر است در نمونه 

A  مقادیر  ،K    شاخص جریان    %50قطر  عمق  افزایش  با 

می نشان  جزئی  افزایافزایش  این  و  مقادیر  دهد؛  در  ش 

نیز تا   Bتر است. این شرایط در نمونه سرعت کم، محسوس

  Kهای  منحنی  Cحدودی مشاهده شده است، اما در نمونه  

نمونه   در  است.  منطبق  برهم  تقریبا  عمق  سه    Cهر 

جورپارامترهای ضر و  معیار  انحراف  یکنواختی،  شدگی  یب 

بطور محسوس دیگر  نمونه  دو  به  به   ینسبت  است؛  بیشتر 

رت دیگر این نمونه نسبت به دو نمونه دیگر یکنواختی  عبا

قطرهای   مقادیر  نمونه  این  در  طرفی  از  دارد.  کمتری 

ریزتر    %50شاخص   دیگر  نمونه  دو  به  نسبت  کوچکتر  و 

 است.
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Fig. 12 The effect of flow depth on the K value of the 

index diameter of 50% in sample A 

در   %50قطر شاخص    Kاثر عمق جریان بر مقدار    12شکل 

   Aنمونه  
 

 
Fig. 13 The effect of flow depth on the K value of the 

index diameter of 50% in sample B 

در   %50قطر شاخص    Kاثر عمق جریان بر مقدار   13شکل 

   Bنمونه  

 

 
Fig. 14 The effect of flow depth on the K value of the 

index diameter of 50% in sample C 

در   %50قطر شاخص    Kاثر عمق جریان بر مقدار   14شکل 

   Cنمونه  

 خطای مطلق نسبی و ضریب همبستگی  -3-4

در های مختلف  ها و سرعتتر با عمق  مقادیر خطا در حالت

  Aمیانگین خطای مطلق نمونه    بیان شده است.  2جدول  

عمق   ریزدانه  سانتی  8و    4در  بخش  در  در    %9متری،  و 

درشت عمق  %2دانه  بخش  در  نیزسانتی   12،  در    متری 

در  %11ریزدانه   مقادیر    % 3دانه  درشت  و  این  آمد.  بدست 

  % 14متر،  سانتی  4برای عمق    %13به ترتیب    Bبرای نمونه  

و    8دانه در عمق  مربوط به درشت  %12ریزدانه و    مربوط به

برای درشت دانه در عمق    %14برای ریزدانه و    %17مقادیر  

نیز میانگین خطای   Cمتر مشاهده شد. در نمونه سانتی 12

-دانهو در درشت  %8ها برابر با در ریزدانه 4مربوط به عمق 

با  ها   عمق  %13برابر  در  ریزدانه سانتی  8،  خطای  متری 

با   با    %9برابر  برابر  دانه  درشت  عمق    %14و  در    12و 

دانه و درشت  %9متری مقادیر خطای ریزدانه برابر با  سانتی

با   آمد.  %14برابر  برای    بدست  همبستگی  ضریب  مقادیر 

 بدست آمد.  1 تقریبا نزدیکها تمامی نمونه

 نتایج فاكتور شکل  -3-5

فاکتور شکل   15  در شکل بر  و سرعت جریان  تاثیر عمق 

نرم پردازش تصویر در  از  برای    Image Jافزار  نتایج حاصل 

قسمت افقی نمودار   ارائه شده است.  A , B , Cی  سه نمونه

و  متر(  سانتی  12متر تا  سانتی  4)از  مربوط به عمق جریان  

به  ستون چپ  از  ترتیب  به  جریان ها  به  مربوط  راست 

می دبی  آخرین  تا  دبی  اولین  با  جریان  در    باشد. ساکن، 

و   رودخانه  نمونه  حالتدر  بستر  بررسی  با  ها  خشک، 

ذرات   عمده  شد  رودخانه  مشاهده  در  بصورت موجود 

هستند.   نمونه  مستطیلی  عمق  Aدر  تمامی  و  در  ها 

ها بطور تقریبی باهم  ها، درصد شکل مستطیلی دانهسرعت

متوسط   )بطور  بوده  باهم  %85برابر  ناچیزی  اختلاف  و   )

-مقادیر درصد شکل مستطیلی دانه  Cو    Bدارند. در نمونه  

متحرک   ها در حالت جریان ساکن، نسبت به حالت جریان

در نمونه    بیشتر تشخیص داده شده است. در    Bاز طرفی 

رصد شکل  هر سه عمق، با افزایش سرعت جریان مقادیر د

دانه نشان میمستطیلی  را  بطوریکه   د،ده ها کاهش جزئی 

حدودا    %80از   عمق    %70به  در  است.    12و    8رسیده 

رابطه فوق    Bمتر نمونه  سانتی بالاترین سرعت جریان،  در 

نمونه   در  نیست.  مشاهده شده    Cبرقرار  این حالت  عکس 

افزایش عم  ،است ق جریان، مقدار درصد شکل  بطوریکه با 

 دهد.  افزایش نشان می %90به حدودا  %80از  یلیمستط

 

 نتیجه گیری  -4
عمق و سرعت    ریتاثدر این تحقیق به صورت آزمایشگاهی  

دانه  انیجر سطح  یبندبر  رسوبات  ذرات  شکل  بستر   یو 

تصو  یشن  یهارودخانه پردازش  روش  از  استفاده  )دو   ریبا 
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گردید.  ی  ابیارز(  Hydraulic Toolboxو    Image Jنرم افزار  

 شود: خلاصه نتایج این تحقیق به صورت زیر ارائه می

رودخانه زنجانرود  یهانمونه ✓ از بستر    بر برداشت شده 

  شن   نوع  از   متحد،   الاتیا  یبندطبقه  ستمیس  اساس

  ی نمونه  به  نسبت  یزتریر  یبنددانه  C  نمونه.  هستند

A    وB  مع  مقدارو    داشت نمونه  این  در    اریانحراف 

 .  بود Bو  A یاز نمونه شتریب

بندی در عمده شرایط هیدرولیکی جریان، منحنی دانه ✓

از نرم بندی الک به منحنی دانه  Image Jافزار  حاصل 

دانه منحنی  مقابل  در  و  بود  نرمنزدیک  افزار بندی 

Hydraulic Toolbox  الک با منحنی  زیادی  ، اختلاف 

 بندیجمع. در یک داشت   Image Jافزار و منحنی نرم

نرم مناسب  دقت  به  توجه  با    در   Image Jافزار  کلی 

دانه منحنی  نرماستخراج  این  نتایج  به  بندی،  افزار 

مقادیر   و  شد  گرفته  نظر  در  کار  مبنای    Kعنوان 

 افزار استخراج شد.قطرهای شاخص این نرم

 

 نتایج خطای مطلق نسبی و ضریب همبستگی  :2جدول 

Table 2 Results of relative absolute error and correlation coefficient 
C B A  

C-12 C-08 C-04 B-12 B-08 B-04 A-12 A-08 A-04  
1 0.996 0.998 0.996 0.998 0.998 0.996 0.997 0.995 Correlation coefficient 

9 9 8 17 14 13 11 9 9 RAE of fine grains (%) 

14 14 13 14 12 13 3 2 2 RAE of coarse grains (%) 

 

   
 

 
Fig. 15 Percentage of rectangular shape of grains in three samples A, B and C 

 Cو    A  ،B  در سه نمونه  ذراتدرصد شکل مستطیلی   15شکل 
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شاخص    K  ریمقاد   ی رو  بر  انیجر  سرعت ✓   %50قطر 

نتا   .نداشت  یمحسوس  ریتاث که مشاهده    جیطبق    شد 

عمق    Aنمونه    K  ریمقاد سه  هر   12و    8و    4در 

  در .  است  ترنییپا   گرید  نمونه  دو   به  نسبت  متریسانت

در    Cو    Bنمونه    K  ر یمقاد  یمتری سانت  8  عمق

رو  یهاسرعت منطبق    یمختلف  همچنبودهم   ن ی. 

عمق    Cنمونه    K  ریمقاد دو    متر یسانت  12و    4در 

 .  بودکمتر   Bنمونه  K  رینسبت به مقاد

نمونه   ✓ شاخص    K  ر یمقاد  ، Aدر  افزا  %50قطر    شیبا 

  در  شیافزا  نیا  و  دادنشان    یجزئ  شیافزا  انیعمق جر

ابود  ترمحسوس  کم،   سرعت  ریمقاد در   طیشرا  نی. 

  C، اما در نمونه  مشاهده شد  ی تا حدود  زین  Bنمونه  

 .  بودبرهم منطبق   بایهر سه عمق تقر K  یهایمنحن

نمونه   ✓ انحراف   ،یکنواختی  بیضر  ی پارامترها  Cدر 

جور  اریمع د  یشدگو  نمونه  دو  به  طور  هب  گرینسبت 

نمونه نسبت    نیا  گری ؛ به عبارت دبود  شتریمحسوس ب

از طرفداشت  یکمتر   یکنواختی  گریبه دو نمونه د  ی . 

و کوچکتر   %50شاخص    یقطرها  رینمونه مقاد  نیدر ا

  . بود زتریر گرینسبت به دو نمونه د

بود  ✓ مستطیلی  غالب  شکل  درصد  نمونه  سه  هر  در 

ها و  در تمامی عمق  Aدرصد(. در نمونه    70)بیش از  

ها بطور تقریبی  مستطیلی دانهها، درصد شکل  سرعت

متوسط   )بطور  بودند  برابر  در %85باهم  طرفی  از   .)

جریان    Bنمونه   سرعت  افزایش  با  عمق،  سه  هر  در 

ها کاهش جزئی را مقادیر درصد شکل مستطیلی دانه

بط داد،  از  کورینشان  حدودا    %80ه  کاهش    %70به 

نمونه   در  شده    Cیافت.  مشاهده  حالت  این  عکس 

افزایش عمیوربط  است، با  ق جریان، درصد شکل  که 

 افزایش نشان داد.  %90به حدودا  %80از  مستطیلی
 

 فهرست علایم  -5

a ذره قطر بزرگ (mm) 

b ذره قطر متوسط (mm) 

c ذره قطر کوچک (mm) 

5 15 35 50 10085,  ,  ,  , ,  d d d d d d ( قطرهای شاخصmm ) 

s-id 
 (mmقطر شاخص الک )

cal-id 
 ( mmمحاسباتی )قطر شاخص 

K بعد( ضریب )بی 

V 
 (m/sمتوسط جریان )سرعت 

Vc  سرعت( بحرانی جریانm/s ) 
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